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QUICK USER’S GUIDE  
 

 
 
 

 

A) Connect the SSW winch to the back of the reading unit. 

 

B) Turn on the reading unit by pressing [ON] quickly. If it does not turn on, wait 5 seconds and try 

again. If possible, it is recommended to warm up the instrument at least half an hour before 

beginning the survey. To do so, press and hold [ON] until the first sound signal stops, then 

release it. Standby will then appear on the display indicating that the probe is connected and 

warming up. 

 

C) Before resetting the memory, make sure that the data have been dumped. To reset the 

memory, press and hold [ON] until the second signal stops, the OFF message will appear on the 

display then simultaneously press [MEM]. Then, you will see the message Memory Reset on the 

display; the unit will turn off by itself. Press again [ON] to turn on the reading unit, the unit will 

initialize. Press on [MEM] key and the # symbol will disappear. 

 

 

DOWN HOLE SURVEY 

 

A) Make sure that you replace the nylon ‘’TIP’’ by the one in stainless steel. To 

begin a survey, first adjust the length of the cable with the winch so that the 

marker on the probe is located at the hole collar. Second, press [MENU] and 

enter the hole name by using the arrow keys. Place the probe away from any 

conductive material by lifting it vertically above your head, to prevent the 

effects which may result from interference with the ground. Initialize the BM8 

reading unit by momentarily pressing [ON]. You must hold the probe in this 

position for about 2 seconds until you hear two consecutive beeps. The # symbol 

will appear on the display, top right, indicating that the system is ready to store 

readings every 0.1 meter. 

 

B) Insert the probe into the hole and lower the probe. At every spacing of 0.1 m, a beep will be 

heard, the depth displayed will increase and the readings will be stored automatically. 

 

C) Once you have reached the bottom of the hole, press [MEM] to stop recording. The # symbol 

will disappear. While rising the SSW probe back to the surface, the depth displayed will 

decrease. Take special care slowing down to avoid hitting the probe against the winch. The 

depth displayed should be close to 0.1 m, when the marker gets out from the hole. 

 

 Repeat steps A, B and C for every hole to survey. 
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UP HOLE SURVEY 

 

A) Make sure that you replace the stainless steel ‘’TIP’’ by the one in nylon, then 

insert the probe into the push rod probe holder. To begin a survey, adjust the 

length of the cable with the winch so that the marker on the probe is located at 

the hole collar. Tighten the cable as well as the brake. Press [MENU] and enter 

the name of the hole using the arrow keys. Place the probe away from any 

conductive material to prevent the effects which may result from interference 

from ground, walls and ceiling. Initialize the BM8 reading unit by momentarily 

pressing [ON]. You must hold the probe in this position until you hear two 

consecutive beeps. The # symbol will appear on the display, top right, indicating that the 

system is ready to store readings every 0.1 meter. 

 

B) Insert the probe into the hole, release the brake and push the probe by keeping the cable taut. 

At every spacing of 0.1 m, a beep will be heard, the distance displayed will increase and the 

readings will be stored automatically. Clip a new push rod by turning it clockwise, it will lock by 

itself. Push the probe and add a new push rod until you reach the bottom of the hole. 

 

C) Once you have reached the bottom of the hole, press [MEM] to stop recording. The # symbol 

will disappear. Pull back the probe, the distance displayed will decrease. Remove the push 

rods one at the time by turning it counterclockwise. Take special care to roll the cable on the 

winch. When the marker gets out from the hole, the distance displayed should be close to 

0.1 m. 

 

 Repeat steps A, B and C for every hole to survey. 

 

NOTE: To turn off the instrument, press and hold [ON] until OFF is shown on the display, and 

then release it. The data is stored in a non-volatile memory and can be transferred later. The 

instrument should be recharged every night. Full charge takes from 4 to 6 hours. If the 

batteries are too weak, the reading unit will send an alarm signal and will display the message 

LOW BATTERY. Shortly afterwards, the readings become meaningless. 

 

NOTE: When the instrument is initialized, the memory address should not reset to zero by 

itself. If this is the case, the data is still in memory and can be retrieved. To continue your 

survey, enter a memory address higher than the number of readings of the last survey. See 

“Next memory”, section 4.5, page 13. 

 

Typical display 
 

 
 

When the # symbol appears on 

the display, all keys are locked. 

Press [MEM] to unlock the keys, 

and store the values appearing on 

the display (see Memory). 
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Basic keyboard 

   [ON] = To turn the BM8 on or to change its state (see 5.2). 

      = To increase or decrease the volume of the beepers (see 5.3). 

     = To increase or decrease the display brightness (se 5.4). 

[MENU] = To navigate in the menu (see 5.5). 

[←] [→] = To select items in the menu (see 5.5). 

 [↑] [↓] = To select characters or digits of the item (see 5.5). 

 [MEM] = To store the data (see 5.5) or to reset the memory (see 6.0). 

 

Signal interpretation 
 

- HFR is the High Frequency Response (relative conductivity) and increases near a conductor 

(conductor content). 

- MAG is the magnetic susceptibility (relative susceptibility) and increases in presence of 

magnetite (magnetic content). 

- Rt is unaffected by the amount of conductive material (intrinsic conductivity). The Rt qualifies 

the conductor from 0 % poor conductor, to 100 % excellent conductor (conductor quality). 

 

Threshold values 
 

The operating parameters of the BM8 as well as their thresholds are: 

Parameters Threshold 

HFR (conductivity): 0-1000-2000-10000-20000-100000-200000 Hz 

MAG (magnetic): No alarm. 

 

Default values 
 

The default settings of the BM8 when you first turn it on are: HN (hole name), 0.1 meter (reading 

spacing) and 0.0 meter (depth). The default alarm level is HFR: 0 Hz (no alarm). To change those 

settings, refer to Basic keyboard. If at any time you become confused with those values, just turn 

the instrument OFF, then ON again to reset all default values. 

 

Memory 
 

The maximum storage capacity of the BM8 is 126,976 readings. A reading at every 0.1 meter 

allows logging 12 kilometers of survey. The memory address is permanently indicated on the 

display. To reset the memory, press and hold [ON] until the second signal stops, and 

simultaneously press [MEM]. Wait until the message Memory Reset appears on the display. The 

unit will turn off by itself.  

 

Warnings 
 

If the display indicates NO HIGH FREQUENCY, NO MEDIUM FREQUENCY, or NO LOW FREQUENCY, 

use another probe. If this other unit is still not working, refer to section 9 of this manual 

(Troubleshooting). 
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1. INTRODUCTION 

2. DESCRIPTION OF THE SSW 

 

 

 

 

 

The SSW is a simple and efficient electromagnetic instrument, which measures the content of 

conductive and/or magnetic material in the ore of a production hole. It can even measure 

conductive bodies in a magnetic environment, and vice versa. With the SSW, you can drastically 

reduce the cost of ore exploitation underground or in open pits. GDD is convinced that the use of 

the SSW at a large scale will bring new life to the exploitation of base metals throughout the 

world. 

 
 

 

 

 

 

 

 

The SSW is a light, portable and efficient electromagnetic instrument. It basically consists of a 

probe, a reading unit (BM8) and a winch. Since the SSW determines the grade and localization of 

the ore, you obtain a log of your production hole to plan blasting sequences, therefore 

minimizing dilution of the ore by waste. 

 

For measuring, you put the probe into the production hole to be logged. The BM8 takes readings 

continuously according to the reading spacing selected while the probe goes down or up the 

hole, and it automatically stores them. The BM8 directly measures three parameters: the relative 

conductivity (HFR – conductor content), the relative susceptibility of the material (MAG –

 magnetite content) and the intrinsic conductivity (Rt - conductor quality). 

 

The capacity of memory is 126,976 readings allowing a survey of 12 kilometers. The memory 

address is permanently indicated on the display. 

 

Two six volts batteries power the BM8, which allows autonomy of eight to ten hours. 
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2.1  Components 

When you receive your SSW, make sure that it contains all components shown on illustration 1. If 

not, please contact Instrumentation GDD Inc. Pay special attention to the terminology used on 

illustration 1 since it will be used throughout this manual. 

 

 

Illustration 1: SSW components 

 

Also included: RS232 and USB data transfer cables 
 

2.2 Specifications 

 Power supply: 2 rechargeable 6-V batteries 

 Daily autonomy: Up to 10 hours 

 Memory capacity: 126,976 readings 

 

 System: Winch: 18 x 36 x 56 cm / 8 kg 

 Reading Unit: 18 x 20 x 6.4 cm / 2 kg 

 Probe: 4 cm (diam.) x 55 cm / 0.34 kg 

 Counterweight: 1.5 kg 

 Carrying case: 8 kg 

 

 Cable length: 30 meters (or upon request) 

 Operating temperature: -40ºC to 70ºC 

 Options: Push rods and probe holder for up holes 
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2.3 Serial Number 

 Winch: SSWXXX 

 Tripod: TRIPODXX 

 Reading unit: #XXXX 

 Probe: WXXXX 

 Battery Charger: #CBWXX 

 Note: X represents a digit number. 

The illustration 2 shows the position of the serial number. 

 
Illustration 2: SSW serial number 

2.4 Wind up cable 

It is very important to properly wind up the cable to move the probe down or up the hole and 

obtain the correct depth. A clockwise turn will make the probe go down the hole and the depth 

will increase on the display of the reading unit. On the opposite, a counter clockwise turn will 

make the probe go up the hole and the depth will decrease on the display of the reading unit. 

Take note that the small pulley always turns in the opposite direction to the big pulley. If the 

small pulley turns clockwise, the big pulley will turn counter clockwise. 

The illustration 3 shows the way to wind up the cable.

 

Illustration 3: SSW wind up cable 
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3. OPERATING PRINCIPLE 
 

 

 

 

The probe contains an inductive coil within its shell. When the probe is in vertical position on the 

hole, as shown on illustration 4, the induction axis sent by the coil is in horizontal position. 

 

Illustration 4: Operating principle 

 

The influence zone of its induction field has an average radius (called "range") of about 

0.5 meter. This field is similar to the field of a magnet. Any conductive or magnetic object within 

the zone reacts by sending out again a secondary field (or "induced field"), which is weaker and 

has distinctive features. The probe reacts on the part of this field that goes through its inductive 

coil. This reaction is then displayed on the reading unit in terms of HFR, MAG and Rt values. 

 

The inductive field is composed of several induction lines crossing the inductive coil, which 

density increases towards the center of the coil. The greater the number of induction lines 

crossing the conductive or magnetic object is, the higher the displayed value is. To illustrate that, 

only a few induction lines are presented on illustration 4. 

 

Following is the meaning of HFR, MAG and Rt values: 
 

- The HFR value (High Frequency Response) represents a specific reaction of the high frequency, 

in hertz, to the presence of a conductor near the probe. (Relative Conductivity). 
 

- The MAG value (Magnetite) represents a specific reaction of the probe, in hertz, to the presence 

of a magnetic body, in particular one containing magnetite. (Relative Susceptibility). 

- The Rt value (Ratio) is not affected by the quantity of conductors present and qualifies the 

conductor from 0 % (poor) to 100 % (excellent). (Intrinsic Conductivity). 
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4. READING UNIT 
 

 

 

 

This chapter describes the various physical and functional components of the reading unit as well 

as instructions on how to use them. 
 

4.1 Reading Unit Elements 

 

Illustration 5: Reading unit 

 

Illustration 5 shows the various visible parts of the reading unit. Here is a short description of the 

function of each one. 

• The display has two lines of 24 characters each. Values, parameters or messages generated 

by the BM8 can be read on it. 

• The conductor status light lights up when any key is pressed or when the conductive level 

is higher than the selected conductive threshold. 

• The magnetic status light lights up when a reading is stored. 

• The conductor beeper (low-pitched sound) is activated when any key is pressed or when 

the conductive level is higher than the selected conductive threshold. 

• The magnetite beeper (high-pitched sound) is activated when a reading is stored. 

• The 11-pin connector links the reading unit to the probe.  

• The DB15 jack is used to upgrade the internal software. It is also used to transfer data to a 

computer with the USB cable. 

•   The RS-232 male is used to connect a GPS. However, this function is currently disabled. 

• The RS-232 female is used for data transfer from the BM8 unit to a computer. 
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• The keys on the keyboard are used to access to the various functions of the BM8, each key 

being identified at its center. In this manual, a word or a symbol in square brackets represents 

the key so identified: for example, [ON] or [→], or [↓]. Here are their specific functions: 

   [ON] = To turn the BM8 on or to change its state (see 5.2). 

     = To increase or decrease the volume of the beepers (see 5.3). 

    = To increase or decrease the display brightness (see 5.4). 

[MENU] = To navigate in the menu (see 5.5). 

[→][←] = To select items in the menu (see 5.5). 

 [↑][↓] = To select characters or digits of the item (see 5.5). 

 [MEM] = To store the data (see 5.5) or to reset the memory (see 6). 
 

4.2 BM8 Estados 

The [ON] key is not only used to turn the BM8 on; it is also used to put the BM8 in one of the 

following three states: Initialization, Standby or Off. 

 

To turn on the instrument, connect the probe and press the [ON] key. The BM8 measures the 

probe reactions and displays values every second. However, measurements are taken every 1/10 

of a second. 

 

If you keep [ON] pressed, the display indicates the following available states in this order (a few 

seconds per choice): 

 

Initialization: (first sound signal) 2 seconds 

Standby:           (silence)                      3 seconds 

Off:                     (second sound signal) 5 seconds 

 

To set the BM8 in the required state, release the [ON] key while the state is displayed. 

 

Initialization: To initialize the BM8, lift the probe vertically above your head, as shown on 

illustration 6, so that the ground does not affect it, and press the [ON] key. Wait until you hear 

two consecutive beeps then insert the probe into the hole. During initialization, the BM8 adjusts 

its signals in order to display zero values when neither conductor nor magnetite is present. 
 

 

 

 

 

 

 

 

 

 

 

 

Illustration 6: Initialization of the SSW 



 

Instrumentation GDD Inc.                          2017-06-06                                                                                    Page 12 

 

 

Standby: To do so, press [ON] until the first sound signal stops, and then release it. Standby will 

then appear on the display. The SSW warms up to stabilize its frequencies. The minimal 

preheating period suggested before beginning a survey is 30 minutes. 

 

Off: To turn off the instrument, press and hold [ON] until OFF is shown on the display, and then 

release it. The BM8 stops all functions. 
 

 

 

4.3 Volume Control 

 

It is possible to increase and decrease the volume of the Beepers. To change the intensity of the 

sound, hold down the key . The volume slowly will increase or decrease. Release it at the 

appropriate volume. The next time you hold down the key , the volume will go in the opposite 

way of the last action. 

 

4.4 Brightness Control 

 

It is possible to increase and decrease the brightness of the display. To change the brightness of 

the display, hold down the key . The brightness slowly will increase or decrease. Release it at 

the appropriate brightness. The next time you hold down the key , the brightness will go in 

the opposite way of the last action. 

 

4.5 Selection of Menu 

 

The BM8 has eight menus. To obtain a menu, press [MENU]. The following menus are displayed: 

 

Hole Name: 
 

NAME 1-ABCDEFGH 

IJKLMNOPQRSTUVWXYZ.*+_? 

 

Date and Time: 
 

    DATE  : DD/MM/AA 

    TIME  : HH:MM:SS 

 

Waiting time and Next Memory: 
 

    WAITING TIME : 4    sec 

    NEXT MEMORY : 89 
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Memory mode and HFR alarm: 
 

█ MEMORY : Auto 

    HFR : 0 

 

Spacing selection and Depth selection: 
 

SPACING : 0.1 

DEPTH : 0.0 

 

Working unit selection: 
 

WORKING  UNIT: Meter 

 

 

Graph and Graph time: 
 

GRAPH :  OFF 

GRAPH TIME : 1.0   sec 

 

When a menu is selected, the keys [←], [→], [↑] and [↓] are used to choose the items. There is no 

[ENTER] key. It is replaced by the waiting time. 

 

 

Hole name 

 

To enter your own hole name, press [MENU] until a name is displayed (either the one by default 

NAME or the one you last entered). The last character is flashing. By pressing [→], the next 

character will be flashing and by pressing [←], the previous one will be flashing. To modify a 

character, use the keys [↑] and [↓]. If no key is pressed for a time greater than the waiting time, 

the BM8 returns to its normal operating mode. Each time the hole name is changed, the BM8 

asks for an INITIALIZATION. Place the probe away from any conductive material by lifting it 

vertically above your head so as to avoid ground effects. Initialize the reading unit by pressing 

[ON] rapidly. You must hold the probe in this position until you hear two consecutive beeps. 

 

NOTE: to obtain the default name NAME at anytime, turn the BM8 off, then on again. 

 

Date and Time 

 
You can set up the date and the time by pressing the key [MENU] until the option Date/Time is 

displayed. The keys [←], [→], [↑] and [↓] are used to adjust the date and the time. The module 

keeps the date and the time in memory even if the unit is off. The date and time has the 

following format: DD/MM/YY. 
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Waiting time and Next Memory 

 

The keyboard of the BM8 has no [ENTER] key. The [ENTER] key is replaced by a waiting time. 

 

Waiting time: 

 

While a menu is selected, if no key is pressed, the menu will be displayed for a few seconds 

(waiting time). 

To select the waiting time press [MENU] until this menu is displayed. A digit will be flashing, by 

pressing [→], the next line will be flashing and by pressing [←], the previous one will be flashing. 

To modify the digit selected use [↑] to increase the value and [↓] to decrease the value. If no key is 

pressed for a time greater than the waiting time, the unit will return to its normal operating 

mode. 

The waiting time selection is from 1 to 9 seconds. The default waiting time value is 4 seconds. 

 

Next memory: 

 

The SSW allows beginning recording values at any memory address. It gives a corresponding 

memory address to the values stored. Every time the unit stores a reading, the memory address 

increases by one. The maximum memory address is the size of the memory divided by 32. The 

size of the memory is shown at the top right corner of the BM8 screen when initializing. 

 

To select the next memory address, press [MENU] until this menu is displayed. The first digit is 

flashing. By pressing [→], the next digit will be flashing and by pressing [←], the previous one will 

be flashing. To modify the digit, use [↑] to increase the value and [↓] to decrease the value. If no 

key is pressed for a time greater than the waiting time, the unit will return to its normal 

operating mode. 

 

NOTE: The memory address begins at zero after a clear or a reset memory. However, if no clear 

or reset has been done before you initialize the probe, the memory address should not have 

changed since the last use. If the memory address has been accidentally reset, enter a new 

address memory greater than the numbers of readings of the last survey. This will avoid 

overwriting previous readings. 

 

Memory mode and HFR alarm 

 

This menu is presented on two lines. The black square indicates the line selected. By pressing [↑] 

or [↓] the black square will move from one line to the other. 

 

Memory mode: 

 

The BM8 allows storing values appearing on the display of the BM8 reading unit. It gives a 

corresponding memory address to the values stored. The memory address appears on the upper 
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right corner of the display. Every time the BM8 stores a reading, the memory address increases 

by one. The maximum storage capacity of BM8 is 126,976 readings. 

 

To select the memory mode, press [MENU] until this menu is displayed. There are two memory 

modes: MANUAL and AUTO. To choose the mode, press [←] or [→], then wait until the BM8 

returns to its normal operating mode. The two memory modes are described below: 

 

- The MANUAL mode allows storing readings manually. When the BM8 is returned to its normal 

operating mode, simply press [MEM] to store the values appearing on the display. 

 

- The AUTO mode allows starting an auto-recording. When the BM8 is returned to its normal 

operating mode, the "#" symbol will appear on the display, top right. This indicates that the BM8 

will be recording values automatically at every spacing selected while going down or up the hole. 

To stop recording press the [MEM] key and the "#" symbol will disappear. 

 

NOTE: When the "#" symbol appears on the display, all keys are locked except the [ON], ,  

and [MEM] keys. This prevents against modifications of the parameters set, while the BM8 is 

recording values. The default memory setting is AUTO, when the BM8 is turned on. 

 

HFR alarm: 

 

The BM8 allows signaling the presence of a conductive material at different thresholds. A red 

light will go on and a sound will be heard when the response to a conductive material exceeds 

the selected threshold. 

 

To select the HFR alarm, press [MENU] until this menu appears on the display. Select the HFR by 

pressing [↓] the black square will move down, and then press [←] or [→] to select the threshold. 

Wait until the BM8 returns to its normal operating mode. The selection of the HFR threshold 

varies from 0 to 200,000 and the values are as follow:  

 

0-1-2-5-10-20-50-100-200-500-1000-2000-5000-10000-20000-50000-100000-200000 Hz 

 

NOTE: The default threshold value for the HFR is 0, no sound. The MAG has no threshold 

selection and it is never signaled. 

 

Spacing selection and Depth selection 

 

Spacing selection: 

 

To select the spacing press [MENU] until this menu is displayed. By pressing [→] or [←], the digit 

of the spacing will be flashing. To modify the digit, use [↑] to increase the value and [↓] to 

decrease the value. If no key is pressed for a time greater than the waiting time, the BM8 will 

return to its normal operating mode. 
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NOTE: There are only two spacing values: 0.1 and 0.2 meter. The default spacing value is 0.1 

meter, when the BM8 is turned on. 

 

Depth selection: 
 

To select the depth press [MENU] until this menu is displayed. The first digit of the next memory 

is flashing. Press [→] or [←] until you reach the digit of the depth to be changed. To modify the 

digit, use [↑], to increase the value and [↓] to decrease the value. If no key is pressed for a time 

greater than the waiting time, the BM8 will return to its normal operating mode. 

 

NOTE: Every time you initialize the probe, the depth returns to 0.0 meter. 

 

Working unit selection 

 

The BM8 allows choosing the working unit either in meter or in feet. 

 

To select the unit press [MENU] until this menu is displayed. Press [→] or [←] the working unit 

will change from Meter to Feet. If no key is pressed for a time greater than the waiting time, the 

BM8 will return to its normal operating mode. 

 

Graph and GraphTime 

 

It is possible to visualize the readings in graphic mode. The graphic mode has the advantage to 

keep on the screen the last 23 readings that were taken. In graphic mode, a conductive anomaly 

is shown by a peak on the first line (up) and a magnetic anomaly by a peak on the second line 

(down). Please note that when the operator first initializes the SSW, the graphic mode is not 

activated. In order to activate it, press the [MENU] key several times until the GRAPH option 

appears. Use the [←] or [→] keys to put this option  ON.  

 

The operator can also adjust the speed of the scrolling with the GRAPH TIME option. Press the 

key [MENU] until the function GRAPH TIME appears on the screen and select the scrolling time 

with the arrow keys [←] or [→]. By default, the scrolling speed is 1.0 second. 
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5. DATA TRANSFER 
 

 

 

 

 

This section will explain how to transfer the data from the BM8 reading module to your 

computer. 

 

First, connect the reading module to a computer as shown in illustration 7. 

 

 
Illustration 7: Connections for data transfer 

 

If your computer does not have a Serial Com Port, connect the BM8 module to your computer 

with the USB cable supplied and see the appendix section: How to install the USB drivers on your 

computer. 

 

Turn your communication software on and press [ON] on the reading unit, the following message 

will appear on the display of the BM. 
 

COMM: 57600,8,N,1 15934 

DEPTH:  0.0 SPACING: 0.1 

 

 

 

 

_______________________________________ 

*See appendix ‘’ How to install the USB drive on your computer’’ 

*See appendix ’’ Configuration of Hyperterminal for windows 7” 
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Make sure that the communication software is in accordance with the instructions on the display 

of the BM8 reading unit. Verify the serial port used on your computer (ex.: COM1). You must 

select the flow control [Hardware] and add the [line feeds character] to the communication 

software. Press ENTER and the following menu should appear on the computer: 
 

SSW 3.1 by Instrumentation GDD Inc. 

MENU ->DUMP(memory_start,memory_end,bypass) 

 Set your software in capture mode, and then send the DUMP command. 

 

 UNIT(value) : Set the unit (Value: M for Meter or F for Feet). 

 

 CLEAR  : Clear or reset the memory of the SSW. 

 

 INIT : Initialize the probe. 

 

 SPACING(value): Set the spacing reading (Value 0.1 or 0.2) 

 

 DEPTH(value): Set the depth (Min.:-999.8,Max.:999.9). 

 

 START : Activate the winch readings. 

 

 ESC key (character ASCII 27) deactivates the winch readings. 

 

GDD > 

Illustration 8: Menu displayed on the computer 

 

This menu presents seven commands. The first three commands are mostly used to transfer data 

from the BM8 to a computer. The last four commands are useful by using a RS-Pen computer in 

RS-232 communication during a survey. In the following sections, characters in bold indicate the 

ones you must type on your keyboard. Note that there is no spacing between the typed 

characters. 
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5.1 Dump data 

 
A- How to create an icon on your desktop for data transfer with Windows XP or NT 

 

1. Start → Programs → Accessories → HyperTerminal  

2. Double-clic on Hypertrm.exe 

3. Name: type BM8 → Select any icon → OK 

4. Phone number: do not type anything here and pass to "Connect using" 

5.  Connect using: select Direct to Com1 or Com2 → OK 

Note: To know which port to select, check where the RS232 cable is plugged on your 

computer. For data transfer with USB cable, see How to install the USB drive on your 

computer in appendix. 

6. ComX Properties → Bits per second: 57600 

Data bits: 8 

Parity: None 

Stop bits: 1 

Flow control: Hardware → OK 

7. BM8 HyperTerminal:  

File → Properties → Settings → ASCII Setup… 

8. ASCII Setup: 

ASCII Receiving: select "Append line feeds to incoming line ends" 

Note: Never select "Force incoming data to 7-bit ASCII". It does not matter whether "Wrap 

lines that exceed terminal width" is selected or not. 

9. OK → OK 

10. File → Save as → Save in: Desktop → Save 

11. Close the window → Yes → Yes 

12. Drag the new icon to the desktop. 

13. Close the window. 

14. If someone else needs the icon, you may copy it to his computer instead of following the 

previous steps. 

 

B- How to transfer the data stored in the reading unit to your computer 

 

1. Connect the reading unit to your computer and turn it on. You need the cable for data transfer 

( RS-232 or USB) provided with the SSW. 

2. Double-click on the icon previously created on your desktop. 

3. Press ENTER on your computer keyboard and you will see a menu appearing on your 

computer screen. 

4. In the tool bar, select Transfer → Capture Text → File: give a name to your file → Start 

5. You must indicate the unit, type unit(_) by replacing the _ with M for meters or F for feet. 

6. Type dump(1,___). In the space at the right of the 1, (___), you type the number of readings 

stored in the memory of the reading unit. To know the number of readings stored, look on the 

reading unit display, top right.  
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7. Press ENTER on your computer keyboard and it will start downloading the data line by line. 

8. Once the transfer is over, go in the tool bar and select Transfer → Capture Text → Stop 

9. Close the window → Yes 

10. You can now unplug the RS-232 cable or USB transfer cable from the BM8 reading unit. 

11. You are now ready to work on your file (ASCII format). 

 

Example of dump command: 

Type DUMP(1,10) and then press on ENTER. If you get an error after typing the dump command, 

see section 5.2 on next page in case you didn’t set the unit. 

 

In the above command, 1 is the first reading transferred (memory_start), 10 is the last reading 

transferred (memory_end). 

 

If the memory address has been reset, you can still transfer your data using the bypass switch. In 

that case, you have to evaluate the number of readings stored in memory, and put a greater 

number for the memory_end. As an example, DUMP(1,5000,,BYPASS) will transfer 5000 readings 

even if there are only 3500 readings in memory. 

 

A message similar to the one shown on illustration 9 should appear on the screen. As you can 

see, 10 readings have been transferred. Note that memory 1 is missing; it represents the header 

at every initialization. 

GDD > unit(M) 

GDD > dump(1,10) 

 

SEARCHING INITIALIZATION... 

 

NAMG          08/03/08 08:19:00 

Memory Meter Meter HFR MAG Rt*1000 DateRTC TimeRTC Bat(%) 

      

 2 0.05 0.15 1645 -1099 55000 08/03/08 08:19:00 75 

 3 0.15 0.25 1795 -1141 54000 08/03/08 08:19:00 75 

 4 0.25 0.35 1577 -1113 55000 08/03/08 08:19:00 75 

 5 0.35 0.45 1766 -1060 54000 08/03/08 08:19:00 75 

 6 0.45 0.55 1514 -1090 56000 08/03/08 08:19:00 75 

 7 0.55 0.65 1794 -1132 54000 08/03/08 08:19:00 75 

 8 0.65 0.75 1505 -1138 56000 08/03/08 08:19:00 75 

 9 0.75 0.85 1814 -1175 54000 08/03/08 08:19:00 75 

 10 0.85 0.95 1551 -1100 56000 08/03/08 08:19:00 75 

 

DUMP MEMORY COMPLETED... 

 

GDD >                            Illustration 9: Typical display following a data dumps 

On illustration 9, the first line transferred is the name of the hole logged, and the second line is 

the header for each column. The first column indicates the memory address. As you can see, that 

number increases by one, from one row to the other. The next five columns respectively present 

the depth (in Meter), the HFR, the MAG and the Rt*1000. 
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5.2 Transfer Unit 

 

The BM8 will not start to dump data until the transfer unit is selected. The BM8 will send ERROR 

7 to remember you to select the transfer unit. The transfer unit does not affect the raw data. You 

can dump data in (M) meter or in (F) feet. 

 

To set the transfer unit type: 

 

UNIT(M) and then press on ENTER 

 

 

5.3 Clear Memory 
 

After the data transfer, you will eventually want to leave space for other readings. In order to do 

so, type: 

 

CLEAR, and then press on ENTER 

 

A message similar to the one shown on illustration 10 should appear on the screen. 

 

GDD > CLEAR 

 

TO  CLEAR  MEMORY  WITH  ALL  ZERO 

ALL DATA WILL BE LOST 

CONFIRM WITH (0000) 

 
TO RESET MEMORY ADDRESS TO ZERO 

 DATA WILL NOT BE LOST 

 CONFIRM WITH (9999) 

Illustration 10: Memory clearing of the BM8 

 

 

This menu shows two choices, clear the memory (0000) or reset the memory (9999). In order to 

clear the memory, type: 0000, and then press ENTER 

  

A message similar to the one shown on illustration 11 should appear on the screen. 
 

0000 

 

PLEASE WAIT, 15 MINUTES… 

(To abort, press the ESC key on computer) 

 

CLEAR MEMORY COMPLETED… 

 

GDD > 

Illustration 11: Confirmation with 0000 
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The confirmation 0000 feeds all the memory space with zero. The memory address is shown on 

the BM8 display and it will increase up to 126,796 then it will be reset to zero. This operation 

takes 15 minutes to be executed. The data will be lost. 

 

In order to reset the memory, type: 9999, and then press ENTER 

 

A message similar to the one shown on illustration 12 should appear on the screen. 
 

9999 

 

PLEASE WAIT, 2 SECONDS… 

 

RESET MEMORY DONE... 

 

GDD > 

Illustration 12: Confirmation with 9999 

 

The confirmation 9999 does not really clear the memory, but reset the memory address to zero. 

The data will not be lost until next readings are stored. The next readings stored will overwrite 

the previous readings. 

 

If you are not using a computer, press [MEM] and [ON] keys simultaneously on the BM8 reading 

unit. This will have the same effect than the 9999 confirmation. 

 

NOTE: It is recommended to confirm with 9999. The data are not lost until next readings are 

stored and previous data can be downloaded to a computer with the BYPASS command. 

 

5.4 Using a RS-Pen or portable computer 

 

A RS-Pen or portable computer may be useful to keep data directly to the computer without 

having to download it later. The following commands are then use for this purpose: 

 

UNIT(value): Set the unit (Value: M for Meter or F for Feet). 

 

INIT: This command initializes the probe; make sure that the probe is hold at the good position. 

The word INITIALIZATION will appear on the display of the BM8 to confirm the operation. 

 

SPACING: This command sets the spacing reading and it will be shown on the BM8 display. 

 

START: This command activates the winch reading sending data to the pen computer. A start 

command can not be initiated, if the probe was not initialized first and the unit was not selected 

previously. 

The ESC: This command disables the readings associated to the winch and the data are not sent 

to the pen computer. 
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 6. CLEAR OR RESET MEMORY 
 

 

 

 

 

To clear or reset the memory of the BM8 while in the field, press and hold [ON] key until the 

message OFF appears on the second line of the display. Keep the [ON] key pressed and press the 

[MEM] key once, the message Reset Memory? will appear on the display, press again and Clear 

Memory? will appear, press again and the display will return to OFF message. Release the [ON] 

key and the selected message will be executed. The BM8 will turn itself off after a clear or reset 

memory. 

 

A reset memory command does not really clear the memory, but reset the memory address to 

zero. The data are not lost until next readings are stored and data can be downloaded to a 

computer with the BYPASS command. 

 

A clear memory feeds all the memory space with zero. The memory address is shown on the BM8 

display and it will increase up to 126,796 then it will be reset to zero. This operation takes 15 

minutes to be executed. The data will be lost. To stop the execution of a clear memory press the 

[MEM] key. 
 

If the message Memory full appears on the display, you must download the data, and then clear 

the memory to add new data. 
 

If the message Memory corrupted appears on the display, you must reset the memory, then 

download the data by using the bypass command. If this does not work, the data are lost. Clear 

the memory, this should remove the message. 
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 7. INTERPRETATION OF VALUES 
 

 

 

 

The SSW probe directly measures three parameters: the relative conductivity (HFR - conductor 

content), the relative susceptibility of the material (MAG - magnetic content) and the intrinsic 

conductivity (Rt - conductor quality). 
 

On the reading unit, press the [ON] key. An initialization message will be displayed, and then the 

following display will appear: 

 
Illustration 13: Typical display on the reading unit 

 

7.1  Relative Conductivity (HFR) 
 

The HFR value (High Frequency Response) represents a specific reaction of the high frequency, in 

hertz, to the presence of a conductor near the probe. The HFR gives the quantity of conductive 

material (relative conductivity). 
 

7.2  Relative susceptibility (MAG) 
 

The MAG value (Magnetic Susceptibility) represents a specific reaction of the probe, in hertz, to 

the presence of a magnetic body, in particular one containing magnetite (relative susceptibility). 

If no conductive materials are present, the MAG value can be converted into magnetic 

susceptibility unit (10-3 SI) by dividing the value by 80 for a hole of 1½”. This value may change by 

a factor of 10% from center to side of the hole. 
 

7.3  Intrinsic Conductivity (Ratio) 
 

The Rt value (Ratio) indicates the quality of a conductor and is independent of the quantity of 

present material (intrinsic conductivity). The Rt is unaffected by the quantity of conductive 

material and qualifies the conductor based on a scale between 0 % (poor) to 100 % (excellent). 
 

7.4  Testing parameters (HFR, MAG and Rt) 
 

You have to find the center of the sensor. To proceed insert the probe in the green ring. You 

should find a minimum HFR response 7 000 between two maximum responses of 20 000. This 

minimum response should be located at about 6’’ (15 cm) from the end of the probe. This is the 

center of the sensor; place a tape as a marker. 
 

Location HFR (+/-5 000) MAG (+/-5 000) Rt (+/-2) 

   2” 20 000 -25 000 41 

   6”   7 000 -15 000 41 

 12” 20 000 -25 000 41 
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 8. BATTERY TESTING 

Bring a metal piece close to the marker (ex.: keys or a can). The HFR value should be positive. The 

ratio value should be near 100 %, indicating an excellent conductor. Take away the metal piece 

from the probe. 

 

NOTE: This test is used to verify the reaction of the probe, not to calibrate it. 

 

 

 

 

8.1 Charging the Batteries 

It is recommended to keep the instrument on charge when it is not in use for a long period. To 

keep the batteries charged, connect the DB-15 jack at the back of the reading unit (see 

illustration 5). 

 
Illustration 14: Battery charger 

 

If the batteries are weak, the reading unit will send a signal and will display Low battery. The 

readings will be meaningless. Connect the 110-240VAC plug to a socket outlet. 

 

If the light does not come on, the power source might be defective or the supply cable might 

have been cut. The Fast charge light indicates that the batteries are charging. When the batteries 

are completely charged, the Fast charge light goes out. Disconnect the charger and the SSW is 

ready to use in the field. 

 

8.2 Testing the Batteries 
 

When the batteries are fully charged, it is possible to verify their capacity. Connect the probe to 

the BM8; reset the memory as mentioned on section 6. Press the [ON] key and hold it down. At 

the same time, press [↓]. The message Battery test should appear on the display. If the message 

does not appear, press again [↓]. Release the [ON] key and the BM8 will start to store readings at 

the rate of one per minute. Let the instrument go on. 

 

When the batteries are empty, a low battery occurs and the BM8 shuts off by itself. Turn on the 

unit and check the memory address shown at the top right corner of the display. This number 

represents the operating time of the BM8 in minutes. This time must be greater than eight hours 

(480 minutes) for good batteries. 
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 9. TROUBLESHOOTING 
 

 

 

 

 

If the instrument does not display anything, first check the display brightness with . If the 

instrument sends out no sounds, first check the volume control with . 

 

If the instrument has no reactions, turn off the reading unit and turn it on again (to reset all 

default values). 

 

If the BM8 is incoherent or if the reading unit indicates a problem such as Low Battery, No High 

Frequency, No Low Frequency, one of the following components might be defective: 

 

-  cables -  probe -  reading unit 

-  batteries -  winch -  battery charger 

 

In order to try to solve the above problems, first check if the cables are correctly screwed on to 

their corresponding connector. Then check if the batteries are charged by using either the 

charger or another SSW charger (see section 8.1 for a description of the charger). If the 

instrument is not working properly, reset or clear the memory as in section 6. If the SSW is still 

not working, clear the memory as shown in section 5.3 using the command 0000. This operation 

will take about 15 minutes to execute. 

 

If you are not sure what the problem is, and the SSW is still not working, call Instrumentation 

GDD Inc. so that arrangements can be taken to ship you another unit as soon as possible while 

the instrument is under repair. Always return the complete instrument with all its components in 

its carrying case. 
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 10. WARRANTY AND REPAIRS 
 

 

 

 

 

10.1 Copyright 

 

Considering GDD’s interest in promoting the SSW, any person interested in duplicating this 

manual is authorized to do so. 

 

10.2 Warranty 
 

The SSW is covered by a one-year warranty on parts and labor. The warranty is void if the 

instrument has been the object of an abusive use, has been opened or modified without 

authorization, or if the serial number on the instrument has been altered, erased or removed. 

 

Instrumentation GDD Inc. is not responsible for any damages and/or losses that may occur during 

transportation or use of the SSW. 

 
10.3 Service 
 

Should the SSW require repairs, please contact Instrumentation GDD Inc. at the numbers below 

in order to receive proper instructions for shipping. When the instrument is under warranty, all 

repairs are done free of charge at our office in Québec (taxes, transportation and customs fees 

are extra). If any instrument manufactured by GDD breaks down while under warranty, a spare 

one will be provided free (taxes, transportation and customs fees are extra) while the instrument 

is under repair (upon request and subject to instruments availability). 

 

Instrumentation GDD Inc. 

860, boul. de la Chaudière, suite 200 

Québec  (Québec)  G1X 4B7 

Tel.: (418) 877-4249 

Fax: (418) 877-4054 

E-Mail: gdd@gdd.ca 

 

Printed in Canada 2016 

 

                    Version: manual-SSW RP-2016-09-28_EN  
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APPENDIX 
 

 

 

 

How to install the USB drivers on your computer 

 

1. Insert the BM8 CD furnished with the SSW in the computer. 

For Windows 7, if the USB driver is not up to date, you will find it on the following web 

site: http://www.ftdichip.com/Drivers/VCP.htm. 

 

2. Plug the BM8 reading unit and the computer together using USB cable. 

3. Put the BM8 reading unit on by pressing [ON] key. 

Typical information showed on the BM8 display (Numbers may differed): 

COMM: 57600,8,N,1 15934 

DEPTH:  0.0 SPACING: 0.1 

4. If the installation doesn’t work properly automatically, you need to do it manually. To do so: 

Left-click on the Start menu, right click on Computer, and left click on Properties. 

Left click on Device Manager 

 

 

 

 

 

 

5. Double-click on the USB Port that is not working 

properly. 

Go in the Driver Tab, and click on the Update Driver tab. 

Click on the second option called: Browse my computer 

for driver software. 

Browse for driver software in the location where you 

put the folder with the driver. You need only to specify 

the location of the folder containing the driver, not pick 

up the driver itself. Include subfolders. 

For example, if the drivers are on a CD disk, you need to: 

Browse → Desktop → My Computer → CD Drive (D:) 

 → Drivers USB → OK 
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6. Click on ‘’Next’’ the computer will install all the necessary drives. 

Click on ‘’Finish’’ when download process is completed. You need to restart your computer. 

7. Then, to know on which port is connected the USB cable, click on My Computer with the right 

button of your mouse and select Properties (same as step 4). 

8. Choose Hardware tab → Device Manager 

9. Click on the + sign next to Ports (COM & LPT) to see which number is associated to the USB 

connexion (COM 1,2,3…). This port number will be useful for the following directives. 

10. Close both windows by pressing red X on the upper right corner. 

 

 

Configuration of Hyperterminal 

 

The Hyperterminal application does not exist for Windows 7. Copy the files: hypertrm.dll and 

hypertrm.exe in your working directory. You will find it in your BM8 CD. 

 

A- How to create a USB port for Hyperterminal 

1. For Windows 7, copy from your BM8 CD the following files: hypertrm.exe and hypertrm.dll. 

Start the hypertrm.exe application by double clicking on it. 

For Windows NT or XP, Start→ Programs→Accessories→ Communication→ HyperTerminal. 

2. Name: BM8USB → click OK. 

3. Define the appropriate COM Port associated to the USB port that 

allows the SSW reading unit to be connected to your computer. 

It can be COM3, COM4, COM5, etc. depending on your computer 

configuration. See appendix How to install the USB drivers on 

your computer on step 7. 

 

 

 

 

4. COMx properties → Bits per second: 57600 

  Data bits: 8 

  Parity: None 

  Stop bits: 1 

  Flow control: None → OK 
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5. BM8USB – HyperTerminal: 

File → Properties →Settings → ASCII Setup 

6. ASCII Setup: 

ASCII Receiving: Select Append line feeds 

to incoming line ends, OK → OK 

 

 

 

7. Close the window → Yes. Save USB named ‘’BM8USB’’? → Yes. This will allow you to go back 

to this page without having to repeat all the previous steps. 

8. For Windows 7, Go to: 

Start → Search Programs and Files → BM8USB.ht and copy this file in your working directory. 

9. For Windows NT or XP, Go to: 

Start → Programs → Accessories → Communication → HyperTerminal. 

Drag the BM8USB.ht to your desktop. 

 

 

Use Hyperterminal for Data Transfer 

 

A- How to transfer Data to your computer 

1. Plug the BM8 reading unit and the computer together using USB cable. 

2. Put the BM8 reading unit on by pressing [ON] key. 

3. Typical information showed on the BM8 display (Numbers may differed): 

COMM: 57600,8,N,1 15934 

DEPTH:  0.0 SPACING: 0.1 

4. For Windows NT or XP, on your computer, double-click on the icon BM8USB.ht previously 

created, then go to step 7. 

5. For Windows 7, on your computer, double-click on Hypertrm. A window will open, click on 

Cancel. 

6. In the bar menu, select File →Open → Browse for the the file BM8USB.ht previously created. 

7. Press ENTER on the computer and the transfer menu should appear.        
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8. In the tool bar, select Transfer →Capture Text…, Browse… give the name and the location 

where your text file (*.txt) will be saved → Start.

 

9. Set the measuring unit by typing the command: unit(m) for meter and unit(f) for feet. 

10. To begin a download, type dump (1, ____) in the space at the right of the 1, ____, you must 

type the number of readings stored in the memory of the reading unit. To know the number of 

readings stored, look on the BM8 display, top right. For example, if there are 2000 readings 

stored, then you must type dump(1,2000). 

11. Press ENTER on your computer keyboard and it will start downloading the data. 

12. Once the transfer is completed, go to the tool bar and select Transfer → Capture Text → Stop 

13. Close the window → Yes 

14. On the BM8, press and hold [ON] key until the second sound signal stops, then release it. The 

unit will turn OFF. You can now unplug the BM8. You are ready to work on your file (ASCII 

format). 

 

How to import a file in Microsoft Excel 

 

1. Open the Microsoft Excel software. 

2. In the tool bar, select File → Open 

3. At Type of Files, select All Files (*.*). At Look in, you have to localize your file. This is very 

important in order to find the file you need. The file extension is .txt. Then select the file you 

want to open → Open 

4. You now have Text Import Wizard - Step 1 of 3. 

5. Select Delimited, Select Next 
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6. You now have Text Import Wizard - Step 2 of 3. 

Select only Space, Select Next 

 

 

 

 

 

 

 

 

 

7. You now have Text Import Wizard - Step 3 of 3. 

At Column Data Format, select General, Select Finish 

 

 

 

 

 

 

 

 

 

 

8. It is very important that you save your file now. To do so, go to the tool bar and select: File → 

Save as: 

Save in: choose the folder in which you want to save it 

Save as type: Microsoft Excel Workbook (*.xls) 

File name: choose the name you want to save and do not forget to put the extension .xls at the 

end of the name. Select Save 
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How to make calculations for grades with Microsoft Excel 

 

1. Give the title "Grade" to column H. Put it on the same row as the other titles (Memory, Meter, 

HFR, etc.) → Enter 

2. At column H, in the first cell below the title, type the following equation: 

=100*(1-2.71828^(-.000075*E?)) → Enter 

Where ^ is the power index, and ? is the row number. 

(2.17828 is the Euler number). 

3. Optional: To get no decimal after the point, do the following: Select column H by clicking on 

the H in the grey zone. In the tool bar, select Format → Cells → Number → Number → 

Decimal places: 0 → OK 

4. Now select all the equation cells from the first one up to the last one in column H. 

5. Go to the tool bar and select Edit → Fill → Down 

6. Make sure that the titles of the lines have been copied correctly everywhere. If not, correct all 

title lines. To do so, use the function Copy to copy the first title line. Position your cursor at the 

line to be changed and use the function Paste. 
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How to make profiles 

1. Select the column D from the title (Meter) to the end of the hole. 

2. Hold the control key and select the column H from the title (Grade) to the end of the hole. If 

you want more profiles on the same graph, hold the control key and select the corresponding 

column.  

3. Select the graphic assistant on the bar menu:  

Click on the data base 

Choose Scatter, click [next] until the end. 

Follow the instructions of the Excel Help, if required. 

When you will be familiar, you will be able to arrange your title, your axis, your color, etc. 

It is advantageous to have a preferred format. Select the graph you prefer, click on the graph and 

then press the right button of your mouse and follow the instructions. 

Examples of profiles obtained with Excel 

Typical graphic of the SSW readings. This graph has three profiles 

 

Graphic of the Sulfides Grade versus HFR. This graph has two profiles 
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Procedures for ‘’Push Rods’’ 

 

a. Put the nylon ‘’TIP’’ at the end of the probe. 

 

 

 

b. Insert the push rod into the probe holder by turning clockwise. Place the probe into the probe 

older and then use electrical tape to fix it. 

 

 
 

c. Loosen the winch brake, adjust the length of the cable so that the marker of the probe is 

located at the hole collar. Tighten the cable as well as the brake. Press the [MENU] button 

and enter the name of the hole using the arrow keys. Place the probe away from any 

conductive material to prevent the effects which may result from interference with the floor, 

walls or ceiling. Initialize the BM8 reading unit by momentarily pressing [ON].  

You must hold the probe in this position for about 2 seconds until you hear two consecutive 

beeps. The # symbol will appear on the display, top right, indicating that the system is ready 

to store readings every 0.1 meter. 

 

     

 

 

d. Insert the probe into the hole, release the brake and push the probe by keeping the cable 

taut. At every spacing of 0.1 m, a beep will be heard, the distance displayed will increase and 

the readings will be stored automatically. Attach a new push rod by turning it clockwise, it will 

lock by itself. Push the probe and add new push rods to reach the end of the hole, always 

keeping the cable taut. 

Push rod 

Tip Probe 

Probe holder 
Marker 

Taut cable at all time 
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e. Once you have reached the bottom of the hole, press [MEM] to stop recording. The # symbol 

will disappear. Pull back the probe, the distance displayed will decrease. Remove the push 

rods one at the time by turning them counterclockwise. Take special care to roll the cable on 

the winch. When the marker gets out from the hole, the distance displayed should be close to 

0.1 m. 

 

f. Repeat steps A, B and C for every hole to survey. 

 

Procedures without the winch  – Quick user’s guide 

Note: Without the use of a winch (for example using a Jumbo probe), you must graduate 

your cable to define the position of the probe into the hole. The data will not be stored 

automatically. When a conductor is encountered, it is recommended to simply write down 

the readings in a notebook, with the associated “depth”. A sketch of the holes surveyed and 

their orientation should also be noted to easily identify the location of conductors. If the 

operator wants to record data in the reading unit, each station needs to be recorded 

manually in the reading unit by pressing the [MEM] twice (see Memory). The borehole 

starting depth, ending depth, and associated memory readings should also be noted in a 

notebook, since they will be used to interpolate readings in a post-survey process. 

a. Connect the probe cable to the back of the reading unit (BM8). 

b. Warming up the probe: 

It is recommended to warm up the instrument for at least half an hour before beginning the 

survey. To do so, press and hold [ON] until the first sound signal stops, then release it. 

Standby will then appear on the display indicating that the probe is connected and warming 

up. If you forgot to put the instrument on standby, initialize the probe as often as you can for 

the first hour. 

c. Initialization: 

To initialize the SSW probe, lift the probe vertically above your head. The probe 

needs to be away from any conductive material, so that the ground, walls and 

ceilling does not affect it. Hold this position with the probe in the air and quickly 

press the [ON] key. Wait until you hear two consecutive beeps (approximately 5 

seconds). During initialization, the BM8 adjusts its signals in order to display 

zero values when neither conductor nor magnetic material is present. After 

initialization, the reading unit should display zero values for the relative 

conductivity (HFR) and magnetic susceptibility (MAG). If it is not the case, re-

initialize the probe again by pressing [ON] quickly and repeat the procedure. 

Once initialized, you can then insert the probe into the borehole and begin the 

survey. It is recommended to initialize the probe between every borehole to be 

surveyed. 
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d. To set the borehole name, date, time, graphic options, etc

the # symbol allowing access to the 

[↑] and [↓] are used to choose the items. To jump from one menu to another, press [MENU] 

more than once. There is no [ENTER] key to confirm your choi

time (4 seconds by default). If no key is pressed for more than the waiting time, the BM8 

returns to its normal operating mode.

e. To turn off the instrument (once the survey is completed), press and hold [ON] until OFF is 

shown on the display, and then release it. The data is stored in a non

can be transferred later. If wet, get the reading unit out of its leather case and store it facing 

down. 

f. The instrument should be recharged every night. Full charge tak

batteries are too weak, the reading unit will send an alarm signal and will display the message 

LOW BATTERY. Shortly afterwards, the readings become meaningless.

 

 

Typical Display 

 

 
 

Basic keyboard 
 

   [ON] = To turn the BM8 on or to change its 

      = To increase or decrease the volume of the beepers

   = To increase or decrease the display brightness (se 5.4).

[MENU] = To navigate in the menu (see 5.5).

[←] [→] = To select items in the menu (see 5.5).

 [↑] [↓] = To select characters or digits of the item (see 

 [MEM] = To store the data (see 5.5) or to reset the memory (see 6.0).

 

Signal interpretation 
 

- HFR is the High Frequency Response (relative conductivity) and increases near a conductor 

(conductor content). 

- MAG is the magnetic susceptibility (rela

magnetite (magnetic content). 

- Rt is unaffected by the amount of conductive material (intrinsic conductivity). The 

the conductor from 0 % poor conductor, to 100
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To set the borehole name, date, time, graphic options, etc., press the [MEM

the # symbol allowing access to the [MENU] key. When a menu is selected, the keys [

↑] and [↓] are used to choose the items. To jump from one menu to another, press [MENU] 

more than once. There is no [ENTER] key to confirm your choices. It is replaced by a waiting 

time (4 seconds by default). If no key is pressed for more than the waiting time, the BM8 

returns to its normal operating mode. 

To turn off the instrument (once the survey is completed), press and hold [ON] until OFF is 

wn on the display, and then release it. The data is stored in a non-volatile memory and 

can be transferred later. If wet, get the reading unit out of its leather case and store it facing 

The instrument should be recharged every night. Full charge takes from 4 to 6 hours. If the 

batteries are too weak, the reading unit will send an alarm signal and will display the message 

LOW BATTERY. Shortly afterwards, the readings become meaningless. 

 

To turn the BM8 on or to change its state (see 5.2). 

To increase or decrease the volume of the beepers (see 5.3). 

To increase or decrease the display brightness (se 5.4). 

To navigate in the menu (see 5.5). 

To select items in the menu (see 5.5). 

To select characters or digits of the item (see 5.5). 

To store the data (see 5.5) or to reset the memory (see 6.0). 

is the High Frequency Response (relative conductivity) and increases near a conductor 

is the magnetic susceptibility (relative susceptibility) and increases in presence of 

is unaffected by the amount of conductive material (intrinsic conductivity). The 

% poor conductor, to 100 % excellent conductor (conducto

When the # symbol appears on 

the display, all keys are locked. 

Press [MEM] to unlock the keys, 

and store the values appearing on 

the display (see Memory).
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M] key to remove 

. When a menu is selected, the keys [←], [→], 

↑] and [↓] are used to choose the items. To jump from one menu to another, press [MENU] 

ces. It is replaced by a waiting 

time (4 seconds by default). If no key is pressed for more than the waiting time, the BM8 

To turn off the instrument (once the survey is completed), press and hold [ON] until OFF is 

volatile memory and 

can be transferred later. If wet, get the reading unit out of its leather case and store it facing 

es from 4 to 6 hours. If the 

batteries are too weak, the reading unit will send an alarm signal and will display the message 

is the High Frequency Response (relative conductivity) and increases near a conductor 

tive susceptibility) and increases in presence of 

is unaffected by the amount of conductive material (intrinsic conductivity). The Rt qualifies 

% excellent conductor (conductor quality). 

When the # symbol appears on 

all keys are locked. 

Press [MEM] to unlock the keys, 

and store the values appearing on 

the display (see Memory). 
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Threshold values 
 

The operating parameters of the BM8 as well as their thresholds are: 

Parameters Threshold 

HFR (conductivity): 0-1000-2000-10000-20000-100000-200000 Hz 

MAG (magnetic): No alarm. 

 

Default values 
 

The default settings of the BM8 when you first turn it on are: HN (hole name), 0.1 meter (reading 

spacing) and 0.0 meter (depth). The default alarm level is HFR: 0 Hz (no alarm). To change those 

settings, refer to Basic keyboard. If at any time you become confused with those values, just turn 

the instrument OFF, then ON again to reset all default values. 

 

Memory 
 

The BM8 allows the storing of values that appear on the display of the BM8 reading unit. It gives a 

corresponding memory address to the values stored. The memory address appears on the upper 

right corner of the display. Every time the BM8 stores a reading, the memory address increases by 

one. 

Before resetting the memory, make sure that the data has been dumped. The maximum storage 

capacity of the BM8 is 126,976 readings. A reading at every 0.1 meter allows logging 12 

kilometers of survey. The memory address is permanently indicated on the display. To reset the 

memory, press and hold [ON] until the second signal stops, and simultaneously press [MEM]. 

Wait until the message Memory Reseted appears on the display. The unit will turn off by itself.  

 

Warnings 
 

If the display indicates NO HIGH FREQUENCY, NO MEDIUM FREQUENCY, or NO LOW FREQUENCY, 

replace the probe. If the unit is still not working, refer to section 9 of this manual 

(Troubleshooting). 


